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Anmerkung für Macintosh Nutzer
Einige Tastenbelegungen (Tastenkürzel) und Menüeinträge unterscheiden sich zwischen der 
Macintosh Version und denen für Windows- und Linux-Rechnern. Die unten stehende Tabelle gibt 
Ihnen einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfedatei des jeweiligen Modules.

Windows/Linux entspricht am Mac Effekt
Menü-Auswahl Extras → 
Optionen

LibreOffice → Einstellungen Zugriff auf die Programmoptionen

Rechts-Klick Control+Klick Öffnen eines Kontextmenüs
Ctrl (Control)
oder Strg (Steuerung)

⌘ (Command) Tastenkürzel in Verbindung mit anderen 
Tasten

F5 Shift+⌘+F5 öffnet den Dokumentnavigator Dialog
F11 ⌘+T öffnet den Formatvorlagen Dialog
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Was ist Impress?
Impress ist die Präsentations-Komponente von LibreOffice. Mit Impress können Sie Folien 
erstellen und als Präsentation oder Diashow abspielen. Die Folien können verschiedene Elemente 
wie Texte, Aufzählungen, Nummerierungen, Tabellen, Diagramme, Clip Arts oder eine breite 
Palette von Grafik-Objekten enthalten. In Impress sind auch eine Rechtschreibprüfung, ein 
Thesaurus, vorgegebene Textstile und Hintergrundstile integriert.

In diesem Kapitel werden verschiedene Gestaltungsmöglichkeiten aufgelistet, die es Ihnen 
ermöglichen, eine Präsentation nach Ihren Wünschen zu erstellen. Details zur Erstellung finden 
Sie im Impress-Handbuch.

Für die Verwendung von aufwändigen Diashows müssen Sie über bestimmte Kenntnisse zu den 
Elementen verfügen, die in den Folien enthalten sind. Folien mit Text verwenden Textstile, um das 
Erscheinungsbild des Textes zu bestimmen. Grafik-Objekte werden auf dieselbe Weise erstellt, wie 
Zeichnungen in Draw erstellt werden. Deshalb empfehlen wir die Beachtung des Kapitels 3 
„Formate und Vorlagen“ sowie des Kapitels 7 „Einführung in Draw“ in diesem Handbuch. 
Außerdem verweisen wir auf die Draw- und Impress-Handbücher.

Impress starten
Sie können Impress auf verschiedene Arten starten:

• Aus dem LibreOffice Start-Center, wenn keine Komponente geöffnet ist.

• Aus dem Systemmenü oder aus dem LibreOffice Schnellstarter. Details unterscheiden sich 
je nach Betriebssystem (mehr dazu im Kapitel 1, „Einführung in LibreOffice“).

• Aus einer geöffneten Komponente von LibreOffice. Klicken Sie dazu auf das Dreieck rechts 

vom Icon Neu  der Symbolleiste Standard und wählen Sie Präsentation aus der 
Auswahlliste. Oder wählen Sie Datei → Neu → Präsentation in der Menüleiste.

Wenn Sie Impress das erste Mal starten, öffnet sich der Präsentations-Assistent (Abbildung 13). 
Hier können Sie nachfolgende Optionen auswählen:

• Leere Präsentation: dies öffnet ein leeres Dokument.

• Aus Vorlage: dies erstellt eine Präsentation aus einer Vorlage Ihrer Wahl.

• Öffnen einer vorhandenen Präsentation.

Wenn Sie in Zukunft den Assistenten nicht mehr verwenden wollen, wählen Sie das 
Kontrollkästchen „Diesen Assistenten nicht mehr zeigen“ an.

Klicken Sie auf Fertigstellen um den Impress-Bildschirm zu öffnen.

Wollen Sie weitere Einstellungen machen klicken Sie auf Weiter. Weitere Informationen hierzu und 
wie Sie den Assistenten verwenden können, finden Sie unter "Eine neue Präsentation erstellen" 
auf Seite 15.

Impress-Hauptfenster
Das Impress-Hauptfenster (Abbildung 1) besteht aus drei Teilen: dem Bereich Folien, dem 
Arbeitsbereich und dem Bereich Aufgaben. Darüber hinaus können beim Erstellen einer 
Präsentation mehrere Symbolleisten angezeigt oder ausgeblendet werden.
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Tipp

Es gibt drei Möglichkeiten, den Bereich Folien oder den Aufgabenbereich 
auszublenden:

1. Klick auf das  in der oberen rechten Ecke des jeweiligen Bereichs.
2. Menüpunkt Ansicht → Folienbereich bzw. Ansicht → Aufgabenbereich. Hier 

können die Bereiche ein- oder ausgeblendet werden.
3. Ein Klick auf den besonders gekennzeichneten Bereich in der Mitte der 

vertikalen Linien, die die einzelnen Bereich trennen. Damit können die Bereiche 
ebenfalls ein- oder ausgeblendet werden.

Bereich Folien
Der Bereich Folien enthält Vorschaubilder aller Folien einer Präsentation - und zwar in der 
Reihenfolge, in der sie während einer Präsentation angezeigt werden. Wenn Sie auf eine Folie in 
diesem Bereich klicken, wird diese Folie im Arbeitsbereich dargestellt und kann bearbeitet werden.

Wenn Sie eine Folie anklicken oder die Strg-Taste gedrückt halten und mehrere Folien gleichzeitig 
anklicken, können Sie verschiedene Aktionen ausführen:

• Neue Folien der Präsentation hinzufügen.

• Eine Folie als ausgeblendet markieren, so dass diese bei der Präsentation nicht angezeigt 
wird.

• Löschen einer Folie aus der Präsentation.

• Umbenennen einer Folie.

• Duplizieren einer Folie (kopieren bzw. einfügen) oder verschieben einer Folie an eine 
andere Position der Präsentation (ausschneiden und einfügen).

Es ist auch möglich, die folgenden Operationen durchzuführen:
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• Änderung des Folienüberganges einer ausgewählten Folie oder nach jeder Folie in einer 
Gruppe von Folien.

• Ändern der Reihenfolge der Folien.

• Ändern des Folien-Designs.

• Gleichzeitiges Ändern des Folienlayouts für eine Gruppe von Folien.

Aufgabenbereich
Der Aufgabenbereich besteht aus fünf Abschnitten. Um einen Abschnitt aufzuklappen, klicken Sie 
auf den nach rechts zeigenden Pfeil links neben der Beschriftung. Es kann nur ein Abschnitt zur 
selben Zeit geöffnet werden.

Masterseiten
Hier definieren Sie den Seitenstil Ihrer Präsentation. Impress enthält vorgefertigte Masterseiten 
(Folienmaster). Eine ist die standardmäßige, leere Vorlage, die anderen haben einen Hintergrund.

Tipp Drücken Sie F11, um das Fenster Formatvorlagen zu öffnen und den Stil eines 
Folienmasters Ihrem Zweck anzupassen. Dies kann jederzeit geschehen.

Layout
Hier werden die vorgefertigten Layouts gezeigt. Sie können Ihre Auswahl ohne Veränderungen 
wählen oder Änderungen entsprechend Ihren Anforderungen vornehmen.

Derzeit ist es nicht möglich, eigene Layouts zu erstellen.

Tabellenentwurf
Die Standardtabellenstile werden in diesem Bereich zur Verfügung gestellt. Sie können die 
Darstellung einer Tabelle ändern, indem Sie bestimmte Zeilen und Spalten anzeigen bzw. 
ausblenden oder den Zeilen und Spalten ein gestaffeltes Aussehen zuweisen.

Benutzerdefinierte Animation
Unter diesem Punkt finden Sie eine Vielzahl von Animationen für die Gestaltung einer Folie. 
Animationen können zu einer Folie hinzugefügt bzw. geändert oder entfernt werden.

Folienübergang
Es gibt ein große Auswahl von Übergängen – einschließlich „kein Übergang“. Sie können z. B. die 
Übergangsgeschwindigkeit (langsam, mittel, schnell) einstellen oder bestimmen, ob der Übergang 
automatisch oder manuell erfolgen soll oder wie lange die ausgewählte Folie angezeigt werden 
soll.

Arbeitsbereich
Der Arbeitsbereich enthält fünf Registerkarten: Normal, Gliederung, Notizen, Handzettel und 
Foliensortierung (Abbildung 2). Diese fünf Registerkarten werden Ansichtsschaltflächen genannt. 
Der Arbeitsbereich unterhalb der Ansichtsschaltflächen hängt von der gewählten Ansicht ab.
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Symbolleisten
Viele Symbolleisten können während der Erstellung der Folie verwendet werden. Sie werden 
angezeigt oder ausgeblendet durch Klicken auf Ansicht → Symbolleisten.

Sie können auch die Symbole ändern, die auf der Symbolleiste erscheinen. Weitere Informationen 
finden Sie in Kapitel 1 „Einführung in LibreOffice“ dieses Handbuches.

Viele der Symbolleisten in Impress sind ähnlich zu den Symbolleisten in Draw. Sie finden im Draw-
Handbuch Informationen über die verfügbaren Funktionen und wie man sie benutzt.

Die Statusleiste
Die Statusleiste (Abbildung 3) am unteren Rand des Impress-Fensters enthält Informationen, die 
nützlich sind, wenn Sie mit einer Präsentation arbeiten. Informationen über die Inhalte und die 
Nutzung dieser Felder finden Sie in Kapitel 1 „Einführung in LibreOffice“ dieses Handbuches und in 
Kapitel 1 „Einführung in Impress“ des Impress-Handbuches.

Hinweis
Die Größen sind in der aktuellen Maßeinheit (nicht zu verwechseln mit der 
Linealeinheit) angegeben. Definieren Sie diese Einheit in Extras → Optionen → 
LibreOffice Draw → Allgemein, wo Sie auch den Maßstab der Seite ändern 
können.

Tipp Wenn Sie diese Option nicht finden können, öffnen Sie bitte ein Draw-Dokument und 
versuchen Sie es erneut.

Eine andere Möglichkeit, die Option zu ändern, wird mit einem Doppelklick auf die Statusleiste 
geöffnet.

Navigator
Der Navigator zeigt alle Objekte, die ein Dokument enthält. Er bietet eine 
weitere bequeme Möglichkeit, sich in einem Dokument zu bewegen und 
Elementen in ihm zu suchen. Um den Navigator anzuzeigen, klicken Sie auf 
das Symbol auf der Symbolleiste Standard, wählen Sie Ansicht → Navigator 
auf der Menüleiste oder drücken Sie Strg+Umschalt+F5.

Der Navigator ist nützlicher, wenn Sie Ihren Folien und Objekten (Bilder, 
Tabellen usw.) einen aussagekräftige Namen anstelle der Standardnamen 
Folie X bzw. Grafik X geben (dabei steht das "X" für eine Zahl). (Abbildung 4)

Arbeitsbereich
Jeder Arbeitsbereich dient der Erleichterung bestimmter Aufgaben. Es ist daher sinnvoll, sich mit 
diesen Arbeitsbereichen vertraut zu machen.
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Ansicht Normal
Die Ansicht Normal ist die Hauptansicht für die Arbeit mit einzelnen Folien. Verwenden Sie diese 
Ansicht, um Formate, Designs, Texte, Grafiken, Folienübergänge und Effekte hinzuzufügen. Um 
eine Folie im Entwurfsbereich Folie (normale Ansicht) zu platzieren, klicken Sie auf die Dia-
Miniaturansicht im Bereich Folien oder per Doppelklick im Navigator.

Ansicht Gliederung
Die Ansicht Gliederung (Abbildung 5) enthält alle Folien der Präsentation in der nummerierten 
Reihenfolge. Sie zeigt das Thema, Titel, Aufzählungen und Nummerierungen für jede Folie im 
Gliederungsformat an. Nur der im Standard-Textfeld jeder Folie enthaltene Text wird angezeigt, 
sodass diese Objekte nicht angezeigt werden, wenn die Folie andere Textfelder oder 
Zeichnungsobjekte enthält. Foliennamen sind ebenfalls nicht enthalten.

In der Ansicht Gliederung können Sie folgende Vorgänge ausführen:

• Den Text einer Folie können Sie hinzufügen oder löschen, wie Sie es von der normalen 
Ansicht gewöhnt sind.

• Die Absätze des Textes können Sie in der ausgewählten Folie nach oben oder unten 

verschieben, indem Sie die Nach oben  oder Nach unten  Schaltfläche der 
Textformatsymbolleisten verwenden.

• Sie können die Gliederungsebene für alle Absätze in einer Folie mit den Schaltflächen der 

nach links  bzw. nach rechts  zeigenden Pfeile ändern, d. h. heraufstufen oder 
herabstufen.

• Vergleichen von Folien mit der Gliederung (wenn Sie eine im Voraus vorbereitet haben). 
Wenn Sie während der Gliederung bemerken, dass eine zusätzliche Folie benötigt wird, 
können Sie diese direkt in der Gliederungsansicht hinzufügen oder zur Normalansicht 
zurückkehren, um eine Folie zu erstellen.

Ansicht Notiz
Verwenden Sie die Ansicht Notiz (Abbildung 6), um Notizen zu einer Folie hinzuzufügen.

1. Klicken Sie auf die Registerkarte Notizen im Arbeitsbereich.

2. Wählen Sie die Folie, bei der Sie Notizen hinzufügen möchten, und klicken Sie auf die Folie 
im Bereich Folien bzw. Doppelklicken Sie auf den Foliennamen im Navigator.

3. In dem Textfeld unter der Folie können Sie nun mit der Eingabe beginnen.
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Tipp
Sie können die Größe des Notizen-Textfeldes mit den blauen 
Größenänderungsgriffen ändern. Sie können auch das Feld durch Ziehen 
verschieben.

Um den Textstil zu ändern, drücken Sie F11. Dadurch wird das Fenster Formatvorlagen geöffnet.

Ansicht Handzettel
Die Ansicht Handzettel dient zum Ändern des Layouts Ihrer Folien für einen gedruckten 
Handzettel. Klicken Sie im Arbeitsbereich Handzettel im Aufgabenbereich auf Layouts. Sie können 
aus Layouts für 1, 2, 3 (mit Platz für erklärenden Text), 4, 6 oder 9 Folien pro Seite wählen.

Arbeitsbereich 11

Abbildung 6: Ansicht Notizen
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Verwenden Sie diese Ansicht auch, um die Informationen auf den Handzettel anpassen. Weitere 
Informationen zum Drucken von Handzetteln finden Sie im Kapitel 10 „Drucken, Exportieren und E-
Mailen“ dieses Handbuches. Wählen Sie im Hauptmenü Einfügen → Seitenanzahl oder Einfügen 
→ Datum und Uhrzeit. In dem Dialogfeld, das sich öffnet, klicken Sie auf den Reiter Notizblätter 
und Handzettel (Abbildung 8). Verwenden Sie dieses Dialogfeld, um Elemente auszuwählen, die 
auf jeder Seite des Handzettels angezeigt werden sollen. Weitere Informationen zur Verwendung 
dieses Dialogfeld werden im Impress Handbuch zur Verfügung gestellt.

Ansicht Foliensortierung
Die Ansicht Foliensortierung (Abbildung 9) enthält die Miniaturansicht aller Folien. Verwenden Sie 
diese Ansicht, um mit einer Gruppe von Folien oder mit nur einer Folie zu arbeiten.
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Ansicht Foliensortierung anpassen
Zum Ändern der Anzahl an Folien pro Zeile, gehen Sie wie folgt vor:

1. Öffnen Sie die Symbolleiste Folienansicht. Dazu wählen Sie Folienansicht unter Ansicht 
→ Symbolleisten aus.

2. Stellen Sie die Anzahl der Folien ein (bis zu max. 15).

Eine Folie in der Ansicht Foliensortierung verschieben
Um eine Folie in der Ansicht Foliensortierung zu verschieben, gehen Sie wie folgt vor:

1. Klicken Sie auf die Folie. Ein dicker, blauer Rahmen wird um sie herum gezeichnet.

2. Ziehen Sie die Folie nun auf die gewünschte Position.

Wenn Sie die Folie bewegen, wird eine schwarze vertikale Linie auf einer Seite der 
anderen Folien angezeigt.

Drücken Sie den Mauszeiger so lange, bis sich diese schwarze vertikale Linie an dem Platz 
befindet, wo die Folie platziert werden soll.

Auswählen und Verschieben von Gruppen von Folien
Wenn eine Gruppe von Folien auswählen möchten, verwenden Sie eine der folgenden Methoden:

1. Verwendung der Taste Strg:

a. Klicken Sie auf die ersten Folie und wählen Sie, während Sie die Steuerungstaste 
gedrückt halten, die anderen gewünschten Folien aus.

2. Verwendung der Umschalt-Taste:
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a. Klicken Sie zuerst auf die erste Folie und danach bei gedrückter Umschalt-Taste auf die 
letzte Folie der unterbrechungsfreien Gruppe.

3. Verwendung der Maus:

a. Klicken Sie auf die Arbeitsfläche links neben von der ersten Folie, die ausgewählt 
werden soll.

b. Halten Sie die linke Maustaste gedrückt und ziehen Sie den Mauszeiger zu einem Platz 
leicht nach rechts von der letzten Folie, die in die Auswahl aufgenommen werden soll. 
(Sie können das in jede beliebige Richtung tun.)

c. Sobald die Miniaturansichten einen dicken Rahmen bekommen, sind sie ausgewählt.

d. Stellen Sie sicher, dass das Rechteck alle Folien enthält, die Sie auswählen möchten.

Um eine Gruppe von Folien zu verschieben, gehen Sie wie folgt vor:

1. Wählen Sie die Gruppe aus.

2. Ziehen Sie die Gruppe an ihre neue Position. Eine vertikale schwarze Linie wird angezeigt, 
um Ihnen zu zeigen, wo die Gruppe der Folien abgelegt werden wird.

Arbeiten mit der Ansicht Foliensortierung
Sie können mit Folien in der Ansicht Foliensortierung arbeiten, wie Sie es im Bereich Folien der 
Normalansicht können.

Um Änderungen vorzunehmen, klicken Sie mit der rechten Maustaste auf eine Folie, um das 
Kontextmenü zu öffnen. Sie können:

• Eine neue Folie nach der ausgewählten Folie einfügen.

• Die ausgewählte Folie umbenennen und löschen.

• Das Folienlayout ändern.

• Den Folienübergang ändern.

• Für mehrere Folien den gewünschten Übergang wählen.

• Folien als ausgeblendet markieren. Diese werden nicht in der Bildschirmpräsentation 
angezeigt.

• Kopieren, Ausschneiden und Einfügen von Folien.

Umbenennen von Folien
Klicken Sie mit der rechten Maustaste auf ein Miniaturbild im Bereich Folien oder in der 
Foliensortierung und wählen Sie Folie umbenennen. Es öffnet sich das Menü Seite umbenennen 
(Abbildung 11). Löschen Sie im Feld Name den alten Namen der Folie, und geben Sie den neuen 
Namen ein. Bestätigen Sie Ihre Änderung mittels Klick auf OK.
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Eine neue Präsentation erstellen
Dieser Abschnitt beschreibt, wie Sie eine neue Präsentation mit Hilfe des Vorlage-Assistenten 
starten.

Wenn Sie Impress starten, wird der Präsentation-Assistent automatisch angezeigt.

Tipp

Wenn Sie den Assistenten nicht bei jedem Start von Impress sehen wollen, 
aktivieren Sie die Option „Diesen Assistenten nicht mehr zeigen“ (Abbildung 13). Sie 
können den Assistenten später unter Extras → Optionen → LibreOffice Impress 
→ Allgemein wieder aktivieren, indem Sie im Abschnitt „Neues Dokument“ das 
Kontrollkästchen Mit Assistenten starten aktivieren

Tipp
Ist die Option Vorschau ausgewählt, erhalten sie eine Miniaturansicht der 
ausgewählten Vorlagen, Foliendesigns und Folienübergänge im Vorschaufeld 
angezeigt.

Schritt 1
Mit der Auswahl leere Präsentation wird eine neue Präsentation ohne Vorbelegungen von 
Grund auf neu erstellt.

Aus Vorlage verwendet einen Vorlagenentwurf, der bereits als Grundlage für eine neue 
Präsentation dient. Der Assistent zeigt nun die verfügbaren Vorlagen an. Wählen Sie die 
gewünschte Vorlage aus.

Öffnen einer vorhandenen Präsentation setzt die Arbeit an einer bereits erstellten Präsentation 
fort. Der Assistent ändert sich, eine Liste der vorhandenen Präsentationen wird angezeigt. 
Wählen Sie die gewünschte Präsentation aus oder suchen Sie durch Klick auf Öffnen nach 
einer.

Die ersten beiden Optionen werden  im Impress-Handbuch genauer behandelt.

Schritt 2
Klicken Sie auf weiter.  Abbildung 13 zeigt den Schritt 2 des Präsentations-Assistent, wie er 
angezeigt wird, wenn Sie leere Präsentation in Schritt 1 ausgewählt haben. Wenn Sie "aus 
Vorlage" ausgewählt haben, wird eine Beispiel-Folie im Feld Vorschau angezeigt.
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Schritt 3
Wählen Sie ein Design unter Wählen Sie eine Seitenvorlage.

Dieser Schritt bietet Ihnen zwei Hauptauswahlmöglichkeiten:

• Präsentationshintergründe und

• Präsentationen

Jede Auswahlmöglichkeit bietet eine Liste von verschiedenen Seitenvorlagen. Wenn Sie eine 
andere als <Original> verwenden möchten, klicken Sie auf diese, um diese auszuwählen.

Die Typen von Präsentationshintergründen sind in Abbildung 13 dargestellt. Wenn Sie auf ein 
Element klicken, sehen Sie eine Vorschau des Dia-Designs im Fenster Vorschau, wenn die 
Option Vorschau aktiviert ist. Impress enthält drei Auswahlmöglichkeiten unter Präsentationen:

• <Original>,

• Empfehlung einer Strategie,

• Vorstellung einer Neuheit.

<Original> ist eine leere Seitenvorlage.

Die beiden anderen, Empfehlung einer Strategie und Vorstellung einer Neuheit, haben ihre 
eigenen vorgefertigten Seitenvorlagen. Jedes Design wird im Vorschaufenster angezeigt, wenn 
der Name angeklickt wird.

Hinweis
Empfehlung einer Strategie und Vorstellung einer Neuheit können auch verwendet 
werden, um eine Präsentation zu erstellen, indem Sie „Aus Vorlage“ im ersten 
Schritt (Abbildung 12) wählen.

Schritt 4
Hier können Sie Auswählen, auf welchem Ausgabemedium die Präsentation später verwendet 
wird.

In den meisten Fällen werden die Präsentationen zur Ausgabe auf Computer-Bildschirmen 
erstellt. Wählen Sie Bildschirm. Sie können das gewählte Seitenformat jederzeit ändern.
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Hinweis
Die Größe der Bildschirmseite ist für eine Anzeige im 4:3-Format (28 x 21 cm) 
optimiert, sodass sie für modernen Breitbild-Displays nicht optimal geeignet ist. Sie 
können die Foliengröße jedoch jederzeit wechseln. Gehen Sie zunächst zur 
Normalansicht. Dann wählen Sie Format → Seite.

Tipp Für die üblichen 16:9 Displays können Sie die Breite auf 37,35 cm ändern.

Schritt 5
Klicken Sie auf weiter. Der Schritt 3 des Präsentations-Assistenten wird angezeigt.

Wählen Sie aus der Auswahlliste Effekt den gewünschten Folienübergang aus.

Wählen Sie aus der Auswahlliste Geschwindigkeit die gewünschte Pausen für den Übergang 
zwischen verschiedenen Folien der Präsentation aus. In den meisten Fällen ist Mittel eine gute 
Wahl.

Schritt 6
Klicken Sie auf Fertigstellen. Eine neue Präsentation wird erstellt.

Tipp
Sie können die Standardwerte für Effekt und Geschwindigkeit unverändert 
übernehmen, da beide Werte auch jederzeit später, während der Arbeit mit 
Folienübergängen und Animationen, geändert werden können. Diese beiden 
Funktionen werden in Kapitel 9 des Impress Handbuchs ausführlicher erläutert.

Hinweis
Wenn Sie aus Vorlage im Schritt 1 des Assistenten ausgewählt haben, wird die 
Schaltfläche weiter direkt zu Schritt 3 springen und andere Seiten werden zur 
Verfügung stehen. Diese Seiten werden hier jedoch nicht beschrieben.

Formatieren einer Präsentation
Eine neue Präsentation enthält nur eine leere Folie. In diesem Abschnitt wird erklärt, wie Sie neue 
Folien hinzufügen und wie Sie die Folien für den von Ihnen vorgesehenen Inhalt vorbereiten.

Einfügen von Folien
Sie können über mehrere verschiedene Wege Folien einfügen. Wählen Sie die Methode, die für 
Sie am einfachsten ist.

• Übers Menü mit Einfügen → Folie.

• Rechtsklick auf eine vorhandene Folie. Wählen Sie dann im Kontextmenü Folie → Neue 
Folie aus.
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• Klicken Sie auf das Icon Folien in der Werkzeugleiste Präsentation.

Manchmal ist es einfacher, anstelle einer neuen Folie eine bereits bestehende Folie zu duplizieren 
und die Änderungen an der Kopie vorzunehmen. Um dies zu tun wählen Sie die Folie in dem 
Folienpanel aus, die Sie duplizieren wollen und wählen Sie dann im Hauptmenü Einfügen → Folie 
duplizieren.

Ein Layout auswählen
In der Aufgabenleiste am rechten Bildschirmrand klicken Sie auf Layout (Abbildung 15), um die 
vorhandenen Layouts anzusehen. Die Layouts unterscheiden sich in der Anzahl und Art der 
Elemente, die eine Folie enthalten kann. Die Anzahl geht von einer leeren Folie bis zu einer Folie 
mit 6 Inhaltsboxen und einem Titel.

Hinweis

Text und grafische Elemente können jederzeit verschoben und angepasst werden 
während der Präsentationserstellung. Die Änderung des Layouts einer Folie, die 
bereits Inhalte enthält, kann dramatische Effekte haben. Es wird daher dringend 
empfohlen, besonderes Augenmerk auf die Auswahl des Layouts zu legen. Wenn 
Sie das Layout einer Folie ändern müssen, nachdem Sie bereits Inhalte eingefügt 
haben, so werden diese Inhalte nicht gelöscht, allerdings müssen Sie sie 
wahrscheinlich neu formatieren.

Die Titel-Folie (die auch einen Abschnitt für einen Untertitel enthält) oder Nur Titel sind passende 
Layouts für die erste Folie, während Sie wahrscheinlich für die meisten Folien ein Titel-Inhalt-
Layout verwenden.
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Tipp

Wenn Sie nicht den Namen für die vorgefertigten Layouts kennen, so bewegen Sie 
Ihren Mauszeiger auf ein Icon in der Layout-Sektion und der Name wird in einem 
kleinen Rechteck angezeigt.
Das kleine Rechteck wird Tooltipp genannt. Falls Tooltipps bei Ihnen deaktiviert sind, 
so können Sie diese über Extras → Optionen → LibreOffice → Allgemein → Hilfe 
aktivieren. Wenn die erweiterten Tooltipps ebenfalls aktiviert sind, so erhalten Sie 
mehr - und detailliertere - Informationen, aber die Namen der Tooltipps werden nicht 
angezeigt.

Mehrere Layouts haben eine oder mehrere Boxen für Inhalt. Jede dieser Boxen kann so 
konfiguriert werden, dass sie eines der folgenden Elemente enthalten kann: Text, Medienclip, Bild, 
Diagramm oder Tabelle.

Sie können den Typ des Inhalts auswählen, indem Sie auf das zugehörige Icon, das in der Mitte 
der Box angezeigt wird, klicken (Abbildung 16). Falls Sie stattdessen nur Text eingeben wollen, so 
klicken Sie irgendwo in die Box, sodass Sie einen Textcursor erhalten.

Um ein Layout auszuwählen oder zu ändern, positionieren Sie Ihre Folie im Arbeitsbereich und 
wählen Sie das gewünschte Layout in der Aufgabenleiste aus.

Wenn Sie ein Layout mit einer oder mehreren Inhaltsboxen ausgewählt haben, so ist jetzt ein guter 
Zeitpunkt um zu entscheiden, welche Art von Inhalt Sie einfügen wollen.

Folienelemente bearbeiten
Zunächst enthält jede Folie nur die Elemente, die auf dem Folienmaster, den Sie verwenden, 
vorhanden sind. Typische Elemente sind Bilder, Logos, Kopf- und Fußzeilen. Es ist allerdings sehr 
unwahrscheinlich, dass die vordefinierten Layouts alle Ihre Bedürfnisse befriedigen. Und obwohl 
Impress keine Möglichkeit hat, neue Layouts festzulegen, so können Sie doch die Größe und 
Position der Layout-Elemente modifizieren. Es ist auch möglich Folienelemente hinzuzufügen, die 
über die Größe und Position der Layout-Boxen hinausgehen.

Um die Größe einer solchen Box zu verändern, klicken Sie bitte auf den äußeren Rahmen, sodass 
Sie die 8 "Griffe" sehen können. Um die Box zu verschieben, positionieren Sie den Mauszeiger auf 
dem Rahmen. Der Mauszeiger verändert dabei seine Form. Jetzt können Sie mit der linken 
Maustaste klicken (gedrückt halten) und die Box an die neue Position verschieben.
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An dieser Stelle können Sie ebenfalls unerwünschte Elemente entfernen. Um das zu erreichen:

• Klicken Sie das Element an, um es auszuwählen (die grünen Griffe zeigen an, dass das 
Element ausgewählt ist).

• Drücken Sie auf die Entfernen-Taste um das Element zu löschen.

Text auf einer Folie eingeben
Wenn die Folie Text enthält, klicken Sie auf Titel/Text durch Klicken hinzufügen um einen Titel bzw. 
Text in dem Textfeld einzufügen. Schreiben Sie Ihren Text. Die verschiedenen Gliederungsebenen 
von 1 bis 10 werden automatisch dem Text zugewiesen, während Sie ihn eingeben. Sie können die 
Gliederungsebene jedes Abschnittes sowie seine Position innerhalb des Textes mit Hilfe der Pfeil-
Schaltflächen in der Symbolleiste Format verändern. Details dazu finden Sie im Abschnitt 
Hinzufügen und Formatieren von Text auf Seite 21.

Erscheinungsbild aller Folien verändern
Um den Hintergrund und andere charakteristische Merkmale aller Folien in der Präsentation zu 
verändern, modifizieren Sie am besten den Folien-Master oder Sie wählen einen zweiten Folien-
Master, wie im Abschnitt Arbeiten mit Folienmastern und Stilen auf Seite 28 erklärt wird.

Wenn Sie nur den Hintergrund austauschen wollen, so können Sie eine Abkürzung nehmen:

• Wählen Sie Format → Seite  und gehen Sie zum Hintergrund-Reiter.

• Wählen Sie den gewünschten Hintergrund aus.

• Klicken Sie auf OK um Ihre Auswahl anzuwenden.

Es öffnet sich eine Dialogbox mit der Frage, ob dieser Hintergrund für alle Folien verwendet 
werden soll. Wenn Sie auf Ja klicken wird Impress den Folienmaster für Sie bearbeiten.

Hinweis
Das Einfügen und korrekte Formatieren eines Hintergrundes geht weit über das Ziel 
dieses Kapitels hinaus. Sie finden jedoch alle hierfür benötigten Informationen in 
Kapitel 4 des Draw-Handbuches bzw. in Kapitel 6 des Impress-Handbuches.

Bildschirmpräsentation bearbeiten
In der Standard-Einstellung wird die Bildschirmpräsentation alle Folien in der gleichen Reihenfolge 
wie in der Foliensortierung anzeigen, ohne irgendwelche Übergänge zwischen den Folien. 
Weiterhin müssen Sie entweder eine Taste drücken oder mit der Maus klicken, um zur nächsten 
Folie zu gelangen.

Sie können den Menüeintrag Bildschirmpräsentation dazu benutzen, um die Reihenfolge der 
Folien zu verändern, auszuwählen, welche Folien gezeigt werden, einen automatischen Übergang 
von einer Folie zur nächsten festlegen und noch einige weitere Einstellungen vornehmen. Um 
Folienübergänge, Animationen für die Folien und Musik zu der Präsentation hinzuzufügen, müssen 
Sie "Benutzerdefinierte Animation" im rechten Aufgabenbereich auswählen. Das Impress-
Handbuch bietet die Details zu all diesen Funktionen.
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Hinzufügen und Formatieren von Text
Die meisten Ihrer Folien werden Text enthalten. Im folgenden Abschnitt wird erklärt, wie Sie Texte 
einfügen und wie Sie das Erscheinungsbild Ihrer Texte verändern können. Alle Texte sind in 
sogenannten Textboxen enthalten.

Es gibt zwei Möglichkeiten Textboxen in eine Folie einzufügen:

• Wählen Sie eines der vordefinierten Layouts aus der Layout-Liste im Aufgabenbereich aus. 
Die vordefinierten Layouts enthalten keine Inhaltsauswahl – also keine Bilder oder Filme 
usw. Diese Textboxen werden AutoLayout-Textbox genannt.

• Erstellen Sie eine Textbox mit Hilfe des Text-Werkzeuges aus der Zeichnen-Symbolleiste.

Mittels Vorgabe-Layout erstellte Textbox
Die folgenden Angaben beziehen sich auf die Ansicht Normal:

• Klicken auf eine Textbox der Layout-Liste im Aufgabenbereich. In der Textbox, die nun im 
Arbeitsbereich zu sehen ist, steht standardmäßig "Titel durch Klicken hinzufügen" oder 
"Text durch Klicken hinzufügen".

• Schreiben Sie den gewünschten Text in die Textbox oder kopieren Sie einen Text aus 
einem bestehenden Dokument in die Textbox.

Selbst erstellte Textbox
Die folgenden Angaben beziehen sich auf die Ansicht Normal:

• Klicken Sie auf das Text-Icon  in der Symbolleiste Zeichnen. Falls die Symbolleiste nicht 
angezeigt wird, können Sie diese über Ansicht → Symbolleiste → Zeichnen anzeigen 
lassen.

• Klicken Sie auf Ihre Folie und zeichnen Sie eine Textbox. Halten Sie dafür die linke 
Maustaste gedrückt und bewegen Sie die Maus über die Folie. Ignorieren Sie die vertikale 
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Höhe der Textbox. Die vertikale Höhe wird automatisch angepasst, wenn Sie einen Text 
eingeben.

• Lassen Sie die Maustaste los, wenn Sie fertig sind. Der Textcursor erscheint in der Textbox, 
die jetzt automatisch im Editier-Modus ist (grauer Rahmen mit den grünen Griffen, wie in 
Abbildung 17 gezeigt).

• Schreiben Sie den gewünschten Text in die Textbox oder kopieren Sie einen Text aus 
einem bestehenden Dokument in die Textbox.

• Klicken Sie irgendwo außerhalb der Textbox, um die Auswahl aufzuheben.

Sie können Textboxen verschieben, deren Größe ändern oder Textboxen löschen. Weitere 
Informationen hierzu finden Sie in Kapitel 3 des Impress-Handbuches.

Hinweis

Zusätzlich zu den "normalen" Textboxen, in denen Text waagrecht ausgerichtet ist, 
ist es auch möglich, Textboxen einzufügen, in denen der Text senkrecht ausgerichtet 
wird. Hierfür müssen Sie die Unterstützung für Asiatische Sprachen in Extras → 
Optionen → Spracheinstellungen → Sprachen aktivieren.

Klicken Sie auf das Icon  in der Zeichnen-Symbolleiste, um eine senkrechte 
Textbox einzufügen. Während Sie die Inhalte dieser Textbox bearbeiten, wird der 
Text waagrecht angezeigt.

Schriftgröße ändern

Die Symbolleiste Format enthält zwei Schaltflächen , mit denen die Schriftgröße des 
ausgewählten Textes vergrößert oder verkleinert werden kann. Wie groß die Veränderung ausfällt, 
hängt von den vorhandenen Standardgrößen der verwendeten Schriftart ab.

Kopierten Text einfügen
Sie können Text in eine Textbox einfügen, indem Sie ihn aus einem anderen Dokument 
herauskopieren und in Impress einfügen. Der eingefügte Text wird sehr wahrscheinlich eine andere 
Formatierung aufweisen als der umfließende Text oder der der anderen Folien. Manchmal ist das 
genau das, was Sie erreichen wollen; Oft wird es allerdings so sein, dass die Präsentation nicht 
wie eine Patchworkdecke mit verschiedenen Absatzformatierungen, Schriftarten, 
Aufzählungszeichen usw. aussehen soll. Es gibt mehrere Wege um eine konsistente Formatierung 
sicherzustellen. Diese Methoden werden nachfolgend erläutert.

Einfügen von unformatiertem Text
Es ist eine gute Angewohnheit, Text ohne Formatierung einzufügen und die vorgesehene 
Formatierung später festzulegen. Um kopierten Text ohne Formatierung einzufügen drücken 
Sie Strg+Umschalt+V und wählen dann Unformatierten Text in dem erscheinenden Dialog oder 

Sie klicken auf das kleine schwarze Dreieck neben dem Einfügen-Symbol  in der 
Standard-Symbolleiste und wählen dort ebenfalls Unformatierten Text. Der unformatierte Text 
wird mit der für das Einfüge-Ziel vorgegebenen Formatvorlage formatiert.

Formatierung von kopiertem Text
Wenn Sie Text in eine AutoLayout Textbox kopieren, so müssen Sie anschließend noch die 
zutreffende Formatierung anwenden, damit der Text genau so aussieht wie der Rest Ihrer 
Dokumentation. (Dies trifft nur zu, wenn Sie den Text nicht als unformatierten Text einfügen.)
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• Fügen Sie den Text an der gewünschten Position ein. Falls der Text anders aussieht: keine 
Sorge, das wird sich in kurzer Zeit ändern.

• Markieren Sie den Text, den Sie eingefügt haben.

• Wählen Sie Format → Standard-Formatierung aus der Standard-Symbolleiste oder 
drücken Sie Strg+M.

• Benutzen Sie die 4 Pfeil-Schaltflächen  in der Text-Formatierungs-Symbolleiste, 
um den Text an die richtige Stelle zu verschieben und die entsprechende 
Gliederungsebene zuzuweisen. Die Schaltfläche mit dem nach links zeigenden Pfeil erhöht 
die Gliederungsebene (z. B. von Gliederung 3 nach Gliederung 2), der nach rechts 
zeigende Pfeil erniedrigt die Gliederungsebene (z. B. von Gliederung 3 nach Gliederung 4). 
Die nach oben und unten zeigenden Pfeile verschieben den Eintrag in der Liste aller 
Gliederungspunkte.

• Wenden Sie - je nach Bedarf - weitere Formatierungen (z. B. Schriftart, Tabulatoren) für 
Teile des Textes an.

Wenn Sie den Text in eine Textbox hineinkopieren, so können Sie auch hier Stile und Vorlagen zur 
schnellen Formatierung des Textes verwenden. Um dies zu tun:

• Kopieren Sie den Text an die gewünschte Stelle.

• Markieren Sie den Text den Sie gerade eingefügt haben.

• Wählen Sie die gewünschte Formatvorlage aus.

• Wenden Sie - je nach Bedarf - weitere Formatierung für Teile des Textes an.

Erstellung von Aufzählungen und nummerierten Listen
Die Vorgehensweise zur Erstellung von Aufzählungen oder nummerierten Listen unterscheidet sich 
je nach verwendeter Art der Inhaltsbox. Die Werkzeuge für die Erstellung und Modifizierung des 
Erscheinungsbildes der Listen sind aber die gleichen.

In den Textboxen, die automatisch von Impress erstellt wurden (die sog. AutoLayout Textboxen), 
sind die Listen automatisch Aufzählungslisten während für normale Textboxen ein zusätzlicher 
Schritt notwendig ist um eine Aufzählung zu erstellen.

Erstellung von Listen in den AutoLayout Textboxen
Jede Textbox, die in den vorhandenen Layouts bereits enthalten ist, ist von Beginn an als 
Aufzählungsliste formatiert. Daher müssen Sie nur die nachfolgenden Schritte ausführen:

• Wählen Sie in der Layoutliste ein Foliendesign aus, das eine Textbox enthält. Diese sind 
sehr leicht über das Vorschaubild zu erkennen.

• Klicken Sie auf die Textbox mit dem Text Titel/Text durch Klicken hinzufügen

• Schreiben Sie den Text, drücken Sie dann auf Enter um den nächsten Aufzählungspunkt zu 
erstellen.

Die Methoden um zwischen Aufzählungen und nummerierten Listen zu wechseln, sind im Abschnitt 
Aussehen der Listen verändern auf Seite 24 erklärt.
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Tipp

Drücken Sie Umschalt+Enter um eine neue Zeile ohne Aufzählungszeichen zu 
beginnen. Die neue Zeile hat den gleichen Zeileneinzug wie die vorherige. Um 
Aufzählungen komplett abzuschalten, klicken Sie bitte auf die 
Aufzählungsschaltfläche in der Formatierungssymbolleiste. Falls diese Symbolleiste 
nicht angezeigt wird, so können Sie diese über Ansicht → Symbolleisten → 
Textformat im Hauptmenü aktivieren.

Erstellung von Listen in anderen Textboxen
Um eine Liste in einer Textbox zu erstellen, führen Sie nachfolgende Schritte aus:

• Platzieren Sie den Cursor in der Textbox.

• Klicken Sie auf die Aufzählungsschaltfläche  in der Formatierungs-Symbolleiste. Falls 
diese Symbolleiste nicht angezeigt wird, können Sie diese über Ansicht → Symbolleisten 
→ Textformat im Hauptmenü aktivieren.

• Schreiben Sie den Text und drücken Sie Enter, um eine neue Aufzählunszeile zu beginnen.

• Die Standardliste ist eine Aufzählungsliste. Die Vorgehensweise, um das Erscheinungsbild 
der Listen zu ändern, ist auf Seite 24 beschrieben.

Eine neue Gliederungsebene erstellen
• Falls notwendig, drücken Sie Enter um eine neue Zeile zu beginnen.

• Drücken Sie auf die Tabulator-Taste. Jedes Mal, wenn Sie die Tabulator-Taste betätigen, 
vergrößert sich der Zeileneinzug auf die Einstellung der nächsten Gliederungsebene. Um 
zur vorherigen Gliederungsebene zurückzukehren, drücken Sie Umschalt+Tabulator.

In den AutoLayout-Boxen wird gleichzeitig mit der Änderung der Gliederungsebene auch die 
Formatierung angepasst. Gliederungsebene 2 hat die Formatierung Gliederung 2, die 3. Ebene hat 
Gliederung 3 als Formatierung usw.

Hinweis
Versuchen Sie bitte nicht, die Gliederungsebene zu ändern indem Sie den Text 
markieren und dann die gewünschte Gliederungsebene - wie Sie das in Writer tun 
würden - anklicken. Bedingt durch die Art und Weise, wie die Präsentationsvorlagen 
funktionieren, ist dies nicht möglich.

Aussehen der Listen verändern
Sie können das Aussehen einer Liste vollständig an Ihre Bedürfnisse anpassen. So ist es zum 
Beispiel möglich, das Aufzählungszeichen oder die Nummerierung für die gesamte Liste oder auch 
nur für einen Eintrag zu ändern. Alle diese Änderungen erfolgen über den Nummerierung- und 
Aufzählungszeichen-Dialog, der über Format → Nummerierung und Aufzählung oder über das 
Aufzählungs-Icon in der Formatierungs-Symbolleiste aufgerufen werden kann.

Änderung für die gesamte Liste:

1. Wählen Sie die gesamte Liste aus oder klicken Sie auf den grauen Rahmen der Textbox, 
so dass die grünen Griffe angezeigt werden.

2. Wählen Sie Format → Aufzählung und Nummerierung oder klicken Sie auf das 

Aufzählungs-Icon .

3. Der Aufzählungs- und Nummerierungs-Dialog enhält fünf Register: Bullets, 
Nummerierungsart, Grafiken, Position und Optionen.
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• Wenn eine Aufzählungsliste benötigt wird, wählen Sie das gewünschte Bulletzeichen 
aus dem Bullet-Register aus.

• Wenn ein Grafik-Stil benötigt wird, wählen Sie eine entsprechende Grafik aus dem 
Grafik-Register aus.

• Wenn eine nummerierte Liste benötigt wird, wählen Sie einen Standard-
Nummerierungsstil aus dem entsprechenden Register aus.

Änderung für einen einzelnen Listeneintrag:

1. Klicken Sie irgendwo in die zu ändernde Zeile, um den Cursor dort zu positionieren.

2. Folgen Sie den Schritten 2 - 3 der vorherigen Anweisungen.

Wenn die Liste innerhalb einer AutoLayout-Textbox erstellt wurde, können Sie alternativ die 
Formatvorlage der Gliederung anpassen, um das Erscheinungsbild der Liste zu verändern. 
Änderungen, die Sie an den Formatvorlagen vornehmen, gelten für alle Folien, die diese Vorlagen 
verwenden. Manchmal ist das genau das, was Sie erreichen wollen. Manchmal ist es das aber 
nicht, sodass Sie hier sehr vorsichtig sein sollten.

Hinzufügen von Bildern, Tabellen, Diagrammen und Medien
Wie bereits beschrieben, können die Inhalts-Boxen neben Text auch Bilder, Tabellen, Grafen oder 
Medienclips enthalten. Dieser Abschnitt möchte Ihnen einen kurzen Überblick darüber geben, wie 
Sie mit diesen Objekten arbeiten können. Detaillierte Informationen finden Sie im Impress-
Handbuch.

Hinzufügen von Bildern
Wenn Sie ein Bild zu einer Inhaltsbox hinzuzufügen wollen, gehen Sie 
folgendermaßen vor:

• Klicken Sie auf die Schaltfläche Bild einfügen (Abbildung 18).

• Benutzen Sie den Dateimanager, um das Bild auszuwählen, das Sie 
einfügen wollen. Um eine Vorschau des Bildes zu sehen, aktivieren 
Sie Vorschau im Dialog Bild einfügen.

• Klicken Sie auf Öffnen.

Das Bild passt sich automatisch an die Größe der Inhaltsbox an. Folgen Sie 
den Anweisungen in der unten stehenden Warnung, wenn Sie die Bildgröße 
von Hand anpassen möchten.

Hinweis
Sie können ein Bild auch außerhalb einer Inhaltsbox zu einer Folie hinzufügen. 
Wählen Sie hierzu Einfügen → Bild → aus Datei und folgen Sie der obigen 
Beschreibung. Sie müssen anschließend das Bild an die gewünschte Position 
verschieben.
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Hinzufügen von Tabellen
Um Daten in Tabellenform darzustellen, können Sie einfache Tabellen direkt in Ihre Folien 
einfügen, indem Sie als Inhaltstyp Tabelle auswählen. Es ist ebenso möglich, eine Tabelle 
außerhalb einer Inhaltsbox auf einer Folie hinzuzufügen. Dazu gibt es folgende Möglichkeiten:

• Wählen Sie Einfügen → Tabelle aus dem Hauptmenü.

• Klicken Sie auf die Schaltfläche Tabelle  in der Symbolleiste Standard.

• Klicken Sie auf die Schaltfläche Tabelle in der Symbolleiste Tabelle.

• Wählen Sie einen Tabellenstil aus dem Tabellendesign im rechten Arbeitsbereich aus.

Jede dieser Methoden öffnet den Dialog Tabelle einfügen (Abbildung 19). Alternativ können Sie 
auch auf den schwarzen Pfeil direkt neben der Schaltfläche Tabelle klicken. Dies öffnet eine 
Schemazeichnung, in der Sie die Anzahl von Spalten und Zeilen für Ihre Tabelle auswählen 
können.

Hinweis
Wenn Sie ein Tabellendesign aus den vordefinierten Stilen auswählen, so wird eine 
Tabelle basierend auf diesem Stil erstellt. Wenn Sie die Tabelle mit einer anderen 
Methode erstellen, können Sie später immer noch einen Stil Ihrer Wahl anwenden.

Wenn die Tabelle ausgewählt ist, erscheint die Symbolleiste Tabelle. Falls dies nicht der Fall ist, 
können Sie die Symbolleiste über Ansicht → Symbolleisten → Tabelle aktivieren. Die 
Symbolleiste bietet fast die gleichen Optionen wie die Symbolleiste Tabelle in Writer. Ausnahme 
hier sind Sortier- und Rechenfunktionen. Um Berechnungen ausführen zu können, müssen Sie 
eine Calc-Tabelle einfügen (Vorgehensweise ist weiter unten beschrieben).

Nachdem die Tabelle erstellt wurde, können Sie sie in gleicher Art und Weise wie eine Tabelle in 
Writer bearbeiten: Hinzufügen und Löschen von Spalten und Zeilen, Anpassen von Spaltenbreite 
und Zeilenhöhe, Rahmen hinzufügen, Hintergrundfarben usw. Detaillierte Informationen hierzu 
finden Sie in Kapitel 9 „Arbeiten mit Tabellen“ des Writer-Handbuchs.
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Mit der Anpassung der Stile im Bereich Tabellendesign können Sie schnell das Erscheinungsbild 
der Tabellen oder von neu erstellten Tabellen verändern. Sie können Kopfzeilen oder 
Summenzeilen einfügen oder die erste und/oder letzte Spalte betonen oder eine alternierende 
Hintergrundfarbe festlegen.

Wenn Sie das gewünschte Tabellen-Design ausgewählt haben, erfolgt die Dateneingabe in die 
einzelnen Zellen ähnlich wie die Texteingabe in Textboxen. Klicken Sie auf eine Zelle, in die Sie 
Daten eingeben wollen und beginnen Sie mit der Eingabe.

Um sich von Zelle zu Zelle zu bewegen, haben Sie die folgenden Möglichkeiten:

• Die Pfeiltasten bewegen den Cursor in die nächste Zelle, sofern die Zelle, in der Sie sich 
befinden, leer ist. Andernfalls bewegt sich Ihr Cursor zum nächsten Zeichen in der Zelle.

• Die Tabulator-Taste bewegt den Cursor in die nächste Zelle. Ein Textinhalt in der Start-Zelle 
wird ignoriert. Umschalt+Tabulator bewegt den Cursor in die vorherige Zelle.

Hinzufügen von Diagrammen
Um ein Diagramm in eine Folie einzufügen, benutzen Sie entweder die Schaltfläche Diagramm 
oder wählen Diagramm als ein Typ der Inhaltsbox aus. In beiden Fällen wird ein Standard-
Diagramm eingefügt. Um das Diagramm anzupassen, fügen Sie Ihre Daten ein und ändern die 
Formatierung nach Ihren Vorstellungen. Detaillierte Hinweise hierzu finden Sie im Impress 
Handbuch.

Hinzufügen von Mediendateien
Sie können Musik- und Film-Clips in Ihre Folie einfügen, indem Sie die Schaltfläche Film 
hinzufügen in einer leeren Inhaltsbox anklicken. Der Medianabspieler wird am unteren Rand des 
Bildschirms eingeblendet, um Ihnen das Abspielen einer Medien-Vorschau zu ermöglichen.

Im Falle einer Audio-Datei, wird der Inhalt der Box mit einem Lautsprechesymbol gefüllt.

Hinzufügen von Grafiken, Tabellenkalkulationen und anderen Objekten
Grafiken wie Formen, Sprechblasen, Pfeile usw. sind oftmals sehr nützlich, um den Text auf einer 
Folie zu ergänzen. Diese Objekte werden ähnlich behandelt, wie Grafiken in Draw. Weitere 
Informationen hierzu finden Sie in Kapitel 7 „Einführung in Draw“ in diesem Handbuch, im Draw-
Handbuch oder in den Kapiteln 4, 5 und 6 des Impress-Handbuches.

Calc-Tabellen die in Impress eingebettet wurden, haben fast die komplette Funktionalität, die sie 
auch in Calc haben. D. h. Sie können damit komplexe Berechnungen und Datenanalysen 
durchführen. Wenn Sie Ihre Daten analysieren oder Formeln anwenden müssen, so werden diese 
Aufgaben am besten in Calc ausgeführt und die Ergebnisse in einer in Impress eingebetteten Calc-
Tabelle oder in einer Impress-Tabelle präsentiert.

Alternativ hierzu können Sie auch Einfügen → Objekt → OLE-Objekte... aus der Menüleiste 
auswählen. Dies öffnet eine Calc-Tabelle in der Mitte der Folie und die Menüs und Symbolleisten 
wechseln zu den in Calc benutzten Einträgen. Sie können sofort mit der Dateneingabe beginnen 
oder Sie passen zuerst die sichtbare Fläche auf der Folie an. Sie können auch eine bestehende 
Datei einfügen und das Darstellungsfeld für die Auswahl der anzuzeigenden Daten auf Ihrer Folie 
benutzen. Impress bietet Ihnen die Möglichkeit, verschiedene Objekttypen wie Writer-Dokumente, 
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Math-Formeln oder sogar andere Impress-Präsentationen in einer Folie einzufügen. Details zur 
Benutzung dieser Objekte finden Sie in Kapitel 7 des Impress-Handbuches.

Arbeiten mit Folienmastern und Stilen
Ein Folienmaster ist eine Folie, die als Ausgangspunkt für andere Folien verwendet wird. Er ähnelt 
einer Seiten-Formatvorlage in Writer. Ein Folienmaster steuert die grundlegende Formatierung 
aller Folien, die darauf basieren. Eine Diashow kann mehr als einen Folienmaster haben.

Hinweis
LibreOffice verwendet drei Begriffe für eine Folie, die verwendet wird, um andere 
Folien erstellen: Masterfolie, Folienmaster und Masterseite. In diesem Handbuch 
wird der Begriff Folienmaster verwendet. Ausnahme ist die Beschreibung der 
Benutzeroberfläche.

Ein Folienmaster enthält eine definierte Gruppe von Eigenschaften - einschließlich 
Hintergrundfarbe, Grafiken, Farbverlauf, Objekte im Hintergrund (wie z. B. Logos, dekorative 
Unterstreichungen und andere Grafiken), Kopf- und Fußzeilen, Platzierung und Größe des 
Textrahmens sowie die Formatierung von Text.

Stile
Alle Merkmale von Folienmastern sind von Stilrichtungen gesteuert. Die Stile einer neuen Folie, die 
Sie erstellen, werden vom Folienmaster geerbt, aus denen die Folie erstellt wurde. Mit anderen 
Worten, die Stile des Folienmasters sind verfügbar und anwendbar auf alle Folien, die aus diesem 
Folienmaster erstellt werden. Ändern einer Formatvorlage in einem Folienmaster führt zur 
Änderung aller Folien basierend auf diesem Folienmaster. Sie können einzelne Folien ändern, 
ohne den Folienmaster zu ändern.

Folienmaster haben zwei Arten von Stilen, die ihnen zugeordnet werden können: 
Präsentationsstile und Grafikstile. Der vorhandene Präsentationsstil kann geändert werden, jedoch 
können keine neuen Präsentationsstile erstellt werden. Im Fall von Grafikstilen können Sie die 
vorhandenen Stile ändern, aber auch neue Stile erstellen.

Präsentationsstile wirken sich auf drei Elemente von einem Folienmaster aus: Hintergrund, 
Hintergrundobjekte (z. B. Symbole, dekorative Unterstreichungen und Textrahmen) und wo der 
Text auf der Folie platziert wird. Formatvorlagen sind weiter unterteilt in Notizen, Gliederung 1 bis 
Gliederung 9, Untertitel und Titel. Die Gliederungen werden für die verschiedenen Ebenen der 
Gliederung verwendet, der sie angehören. Beispielsweise dient Gliederung 2 als Unterpunkt von 
Gliederung 1 und Gliederung 3 ist der Unterpunkt von Gliederung 2.

Grafikstile beeinflussen viele Elemente einer Folie. Beachten Sie, dass bei Präsentations- und 
Grafikstilen die Stilauswahl für Textstile vorhanden ist.

Folienmaster
Impress verfügt über mehrere vorgefertigte Folienmaster. Sie werden im 
Abschnitt Masterseiten im Aufgabenbereich angezeigt. Dieser Abschnitt 
enthält drei Unterbereiche:

• In dieser Präsentation verwendet

• Zuletzt verwendet

• Zur Verwendung vorhanden

Klicken Sie auf das Plus-Symbol neben dem Namen eines Unterabschnitts 
um diesen zu erweitern und die Miniaturansichten der Folien anzuzeigen, 
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oder klicken Sie auf das Minus-Symbol neben den Namen des Unterabschnittes, um die 
Vorschaubilder wieder auszublenden. Jeder der Folienmaster, der im Untermenü Zur Verwendung 
vorhanden gezeigt wird, kommt von einer Vorlage mit dem gleichen Namen. Wenn Sie eigene 
Vorlagen erstellt oder Vorlagen aus anderen Quellen hinzugefügt haben, erscheinen die 
Folienmaster von diesen Vorlagen in dieser Liste.

Erstellen eines  neuen Folienmasters
Das Erstellen eines neuen Folienmasters ist ähnlich wie das Ändern des Standardfolienmasters.

Um beginnen zu können, Aktivieren Sie die Bearbeitung von Folienmastern unter Ansicht → 
Master → Folienmaster.

Klicken Sie auf der Symbolleiste Masteransicht auf das Symbol Neuer Master .

Ein zweiter Folienmaster wird im Bereich Folien angezeigt. Passen Sie diesen Folienmaster an 
Ihre Anforderungen an. Es wird empfohlen, den neuen Folienmaster umzubenennen: Klicken Sie 
dazu, wie auch bei einer normalen Folie, mit der rechten Maustaste auf die Vorschau der Folie im 
Bereich Folie und wählen Sie anschließend aus dem Kontextmenü Master umbenennen.

Wenn Sie fertig sind, schließen Sie die Masteransicht, um in den normalen Bearbeitungsmodus 
zurückzukehren.

Anwenden eines Folienmasters
Stellen Sie im Aufgabenbereich sicher, dass der Abschnitt Masterseiten angezeigt wird.

• Um einen der Folienmaster für alle Folien in der Präsentation anzuwenden, klicken Sie mit 
der rechten Maustaste auf diesen und wählen im Kontextmenü Für alle Folien 
übernehmen.

• Um einen Folienmaster nur auf ausgewählte Folien anzuwenden, klicken Sie im 
Kontextmenü auf Für ausgewählte Folien übernehmen.

Laden von zusätzlichen Folienmastern
Manchmal müssen Sie in den gleichen Satz von Folien mehrere Folienmaster mischen, die zu 
verschiedenen Vorlagen gehören. Zum Beispiel kann die erste Folie ein völlig anderes Layout 
haben als die anderen Folien oder Sie möchten Ihre Präsentation eine Folie aus einer anderen 
Präsentation (basierend auf einer Vorlage, die auf der Festplatte verfügbar ist) hinzufügen.

Das Dialogfeld Foliendesign macht dies möglich. Um auf dieses Dialogfeld zuzugreifen, wählen 
Sie entweder aus der Menüleiste Format → Foliendesign oder durch einen Rechtsklick auf eine 
Folie im Bereich Folien aus dem Kontextmenü Foliendesign.

Das Hauptfenster des Dialogs zeigt die Folienmaster (Seitenvorlagen) (Abbildung 22 und 23) die 
bereits zur Verfügung stehen. So fügen Sie weitere hinzu:

• Klicken Sie auf die Schaltfläche Laden.

• Wählen Sie im neuen Dialog die Vorlage, die den Folienmaster enthält. Klicken Sie auf OK.

• Klicken Sie auf OK, um das Seitenvorlagendialogfeld zu schließen.
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Der Folienmaster in der Vorlage, die Sie ausgewählt haben, wird nun auch im Abschnitt 
Masterseiten als Zur Verwendung Vorhanden im Aufgabenbereich angezeigt.

Hinweis

Der Folienmaster, den Sie geladen haben, wird auch das nächste Mal, wenn Sie die 
Präsentation laden, zur Verfügung stehen. Um die nicht verwendeten Folienmaster 
zu löschen, klicken Sie auf das entsprechende Kontrollkästchen im Dialogfeld 
Seitenvorlage. Dadurch wird die Masterseite auf jeden Fall aus der Liste der 
verfügbaren Folienmaster entfernt.

Tipp Um die Größe der Präsentationsdatei einzuschränken, können Sie die Anzahl von 
verwendeten Folienmastern minimieren.

Ändern eines Folienmasters
Die folgenden Elemente können auf einem Folienmaster geändert werden:

• Hintergrund (Farbe, Farbverlauf, Schraffierung oder Bitmap).
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• Hintergrund-Objekte (z. B. können ein Logo oder dekorative Grafiken hinzugefügt werden).

• Größe, Platzierung und Inhalt der Kopf- und Fußzeile, die auf jeder Folie angezeigt 
werden.

• Größe und Platzierung von Standardelementen, wie Folientitel und Inhalt.

Bevor Sie mit dem Folienmaster arbeiten, stellen Sie sicher, dass das Formatvorlagen-Fenster 
geöffnet ist.

Um den Folienmaster zum Bearbeiten auszuwählen, gehen Sie wie folgt vor:

• Wählen Sie Ansicht → Master → Folienmaster aus der Menüleiste. Dies entsperrt die 
Eigenschaften des Folienmasters, damit diese bearbeitet werden können.

• Klicken Sie im Aufgabenbereich auf Masterseiten. Damit haben Sie Zugriff auf die 
gebrauchsfertigen Folienmaster.

• Klicken Sie auf den Folienmaster, den Sie ändern möchten (Abbildung 22).

• Nehmen Sie die erforderliche Änderungen vor und schließen die Masteransicht 
anschließend durch Klick auf Masteransicht schließen in der Symbolleiste Masteransicht. 
Einzelheiten finden Sie in Kapitel 2 des Impress-Handbuchs

Speichern Sie die Datei, bevor Sie fortfahren.

Die vorgenommenen Änderung von Folien in der Normalansicht (zum Beispiel Änderungen des 
Textelements, Stil oder die Farbe des Titelbereichs usw.) wird durch nachfolgende Änderungen an 
dem Folienmaster nicht überschrieben. Es gibt jedoch Fälle, wo es wünschenswert ist, für ein 
manuell geändertes Element der Folie auf den im Folienmaster definierten Stils zurückkehren: Um 
das zu tun, wählen Sie dieses Element aus und wählen Sie Format → Standardformatierung aus 
der Menüleiste oder drücken Sie Strg+M.

Verwenden eines Folienmasters zum Hinzufügen von Text auf alle 
Folien
Einige der mitgelieferten Folienmaster haben Textobjekte in der Fußzeile. Sie können die 
Masterseite für die Folien um ein als Kopfzeile oder Fußzeile fungierendes anderes Textobjekte 
erweitern.

• Wählen Sie Ansicht → Master → Folienmaster aus der Menüleiste.

• Wählen Sie auf der Symbolleiste Zeichnen dieText Schaltfläche.

• Klicken Sie einmal und zeichnen Sie mit gedrückter Maustaste ein Textfeld. Geben Sie nun 
Ihren Text oder ein Objekt, wie unten beschrieben, ein.

• Wählen Sie Ansicht → Normal, wenn Sie fertig sind.

Die Impress-Folienmaster kommen mit drei vorkonfigurierten Bereichen für Datum, Fußzeile und 
Seitenzahl (Abbildung 24).
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Wählen Sie Einfügen → Seitenzahl... oder Einfügen → Datum und Uhrzeit..., um ein Dialogfeld 
zu öffnen, wo Sie diese drei Bereiche konfigurieren können.

Tipp

Um das Zahlenformat für das Seitenzahlenfeld (1, 2, 3; a, b, c oder i, ii, iii, u. s. w.) 
zu ändern, wählen Sie Format → Seite und wählen Sie ein Format aus der Liste im 
Bereich Layouteinstellungen.
Zum Ändern des Absatzstils ändern Sie den Präsentationsstil des 
Hintergrundobjektes.

Um weitere Informationen, wie z. B. den Autor der Präsentation oder den Namen der Datei, 
hinzuzufügen, wählen Sie Einfügen → Feldbefehle und klicken Sie auf den benötigten Eintrag 
aus dem Untermenü. Wenn Sie ein Feld in der Folie bearbeiten möchten, markieren Sie es und 
wählen Bearbeiten → Feldbefehl...
Die Felder, die Sie in Impress verwenden können, sind:

• Datum (fest)

• Datum (Variabel) — automatisch aktualisiert, wenn Sie die Datei erneut laden

• Zeit (fest)

• Zeit (Variabel) — automatisch aktualisiert, wenn Sie die Datei erneut laden

• Autor — Vor- und Nachnamen, wie in den LibreOffice-Benutzerdaten aufgeführt
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• Seitenzahl (Foliennummer)

• Dateiname

Tipp Um die Autoreninformationen zu ändern, gehen Sie zu Extras → Optionen → 
LibreOffice → Benutzerdaten.

Hinzufügen von Kommentaren zu einer Präsentation
Impress unterstützt Kommentare ähnlich denen in Writer und Calc.

Wählen Sie in der Normalansicht Einfügen → Kommentar aus der Menüleiste. Ein kleines Feld 
enthält Ihre Initialen und wird in der oberen linken Ecke der Folie, verbunden mit einem größeren 
Textfeld daneben, angezeigt. Impress fügt automatisch Ihren Namen und das aktuelle Datum am 
unteren Rand des Textfeldes ein (Abbildung 26).

Geben Sie Ihren Kommentar in das Textfeld ein. Sie können optional einige grundlegende 
Formatierungen auf Teile des Textes mit der rechten Maustaste aus dem Kontextmenü anwenden. 
(Aus diesem Menü können Sie auch den aktuellen Kommentar, alle Kommentare vom selben Autor 
oder alle Kommentare im Dokument löschen.)

Sie können die kleinen Kommentar-Marker an eine beliebige Stelle verschieben, die Sie 
wünschen. Naheliegend wäre ein Ort, in der Nähe des Objektes, auf den sich der Kommentar 
bezieht.

Zum Ein- oder Ausblenden der Kommentarmarkierungen, wählen Sie Ansicht → Kommentare.

Wählen Sie Extras → Optionen → Benutzerdaten, um den Namen, der als Autor angezeigt wird, 
zu ändern.

Wenn mehr als eine Person das Dokument bearbeitet, wird automatisch jedem Autor eine andere 
Hintergrundfarbe zugewiesen.
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Bildschirmpräsentation einrichten
Wie bereits in Bildschirmpräsentation bearbeiten auf Seite 20 erwähnt, hat Impress angemessene 
Standardeinstellungen für Dia-Shows, die gleichzeitig das Anpassen vieler Aspekte der Diashow-
Erfahrung ermöglichen. In diesem Abschnitt werden nur einige Aspekte genannt, erweiterte 
Techniken werden in Kapitel 9 "Dia-Shows" im Impress-Handbuch erläutert.

Die meisten Aufgaben sind am besten in der Ansicht Foliensortierung zu erledigen, weil Sie viele 
Folien gleichzeitig sehen können. Wählen Sie Ansicht → Foliensortierung aus der Menüleiste 
oder klicken Sie auf die Foliensortierung Registerkarte am oberen Rand des Arbeitsbereichs.

Aus den gleichen Folien mehrere verschiedene Präsentationen erstellen
Wenn Sie feststellen, dass Sie in der vorgegebenen Zeit nicht alle Folien präsentieren können, 
oder Sie möchten Ihren Zuhörern nur einen kurzen Überblick über ein Thema geben, ohne sich in 
Details zu verstricken, können Sie zwei Tools nutzen, die es Ihnen ermöglichen, das bestehende 
Dokument weiterhin zu verwenden: das Ausblenden von Folien und die benutzerdefinierte Dia-
Show.

Um eine Folie auszublenden, klicken Sie mit der rechten Maustaste auf die Dia-Miniaturansicht im 
Folienfenster oder im Arbeitsbereich. Wenn Sie die Foliensortierungsansicht verwenden, wählen 
Sie Folie ausblenden aus dem Kontextmenü. Ausgeblendete Folien werden durch eine 
durchgestrichene Foliennummer gekennzeichnet.

Wenn Sie die Präsentation neu anordnen möchten, wählen Sie Bildschirmpräsentation → 
Individuelle Bildschirmpräsentation. Klicken Sie auf die Schaltfläche Neu, um eine neue 
Bildschirmpräsentation zu definieren und zu speichern.

Dadurch können Sie beliebig viele verschiedene Präsentationen aus den gleichen Folien erstellen.

Folienübergänge
Als Folienübergang bezeichnet man eine Animation im Rahmen eines Foliewechsels. Sie können 
im Aufgabenbereich unter Folienübergang (ganz unten) die Folienübergänge der ausgewählten 
Folien bestimmen. Wählen Sie den gewünschten Übergang sowie die Geschwindigkeit der 
Animation aus. Sie haben auch die Möglichkeit, den Übergang zu gestalten: Mausklick 
(empfohlen) oder automatischer Übergang nach einer bestimmten Anzahl von Sekunden. Klicken 
Sie auf Für alle Folien übernehmen - außer Sie ziehen es vor, verschiedene Übergänge in der 
Präsentation zu benutzen.

Tipp
Der Bereich Folienübergang hat eine äußerst nützliche Funktion - die automatische 
Vorschau. Wenn Sie die Kontrollkästchen aktivieren, wird beim Vornehmen von 
Änderungen des Folienübergangs der neue Übergang im Bereich Dia-Design 
einschließlich seines Übergangseffekts angezeigt.

Automatisch zur nächsten Folie wechseln
Im Menü Bildschirmpräsentation → Bildschirmpräsentationseinstellungen können Sie 
einstellen, ob die Folie automatisch nach einer voreingestellten Zeit gewechselt werden soll (z. B. 
im Kiosk- oder Karussell-Modus).

Um dieses einzurichten, wählen Sie die Bildschirmpräsentation → Bildschirmpräsentation mit 
Zeitnahme. Wenn Sie dieses Tool verwenden, startet eine Bildschirmpräsentation, bei der eine 
kleine Uhr an der linken unteren Ecke angezeigt wird. Wenn Sie zur nächsten Folie wechseln 
möchten, klicken Sie auf die Uhr. Impress wird sich die Zeit merken und bei der nächsten 
Bildschirmpräsentation nach dieser Zeitspanne automatisch zur nächsten Folie übergehen.
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Ausführen einer Diashow
Es gibt folgende Möglichkeiten, eine Bildschirmpräsentation auszuführen:

• Klicken Sie auf Bildschirmpräsentation → Bildschirmpräsentation.

• Klicken Sie auf die Schaltfläche Bildschirmpräsentation auf der Symbolleiste Präsentation 
(Abbildung 14).

• Drücken Sie F5 oder F9 auf der Tastatur.

• Um jedoch eine Bildschirmpräsentation zu beenden, gibt es nur eine einzige Möglichkeit - 
die Taste ESC.

Wenn der Folienübergang automatisch nach x Sekunden erfolgt, können Sie die Dia-Show auch 
unbeaufsichtigt ablaufen lassen.

Wenn der Folienübergang durch einen Maus-Klick ausgelöst wird, führen Sie eine der folgenden 
Möglichkeiten zum Wechseln von einer Folie zur nächsten aus:

• Verwenden Sie die Pfeiltasten auf der Tastatur, um zur nächsten Folie zu gehen oder zur 
vorherigen zurückzukehren.

• Klicken Sie auf die linke Maustaste, um zur nächsten Folie zu wechseln.

• Drücken Sie die Leertaste auf der Tastatur, um zur nächsten Folie zu wechseln.

Wenn Sie während einer Bildschirmpräsentation die rechte Maustaste betätigen, öffnet sich ein 
Menü, von dem aus Sie zu den anderen Folien navigieren können. In diesem Menü können Sie 
auch noch andere Optionen festlegen. Genauere Informationen hierzu und viele andere 
Erklärungen finden Sie im Impress-Handbuch.

Ausführen einer Diashow 35


	Englisches Originaldokument
	Anmerkung für Macintosh Nutzer
	Was ist Impress?
	Impress starten
	Impress-Hauptfenster
	Bereich Folien
	Aufgabenbereich
	Masterseiten
	Layout
	Tabellenentwurf
	Benutzerdefinierte Animation
	Folienübergang

	Arbeitsbereich
	Symbolleisten
	Die Statusleiste
	Navigator

	Arbeitsbereich
	Ansicht Normal
	Ansicht Gliederung
	Ansicht Notiz
	Ansicht Handzettel
	Ansicht Foliensortierung
	Ansicht Foliensortierung anpassen
	Eine Folie in der Ansicht Foliensortierung verschieben
	Auswählen und Verschieben von Gruppen von Folien
	Arbeiten mit der Ansicht Foliensortierung
	Umbenennen von Folien


	Eine neue Präsentation erstellen
	Formatieren einer Präsentation
	Einfügen von Folien
	Ein Layout auswählen
	Folienelemente bearbeiten
	Text auf einer Folie eingeben
	Erscheinungsbild aller Folien verändern
	Bildschirmpräsentation bearbeiten

	Hinzufügen und Formatieren von Text
	Mittels Vorgabe-Layout erstellte Textbox
	Selbst erstellte Textbox
	Schriftgröße ändern
	Kopierten Text einfügen
	Formatierung von kopiertem Text
	Erstellung von Aufzählungen und nummerierten Listen
	Erstellung von Listen in den AutoLayout Textboxen
	Erstellung von Listen in anderen Textboxen

	Eine neue Gliederungsebene erstellen
	Aussehen der Listen verändern

	Hinzufügen von Bildern, Tabellen, Diagrammen und Medien
	Hinzufügen von Bildern
	Hinzufügen von Tabellen
	Hinzufügen von Diagrammen
	Hinzufügen von Mediendateien
	Hinzufügen von Grafiken, Tabellenkalkulationen und anderen Objekten

	Arbeiten mit Folienmastern und Stilen
	Stile
	Folienmaster
	Erstellen eines  neuen Folienmasters
	Anwenden eines Folienmasters
	Laden von zusätzlichen Folienmastern
	Ändern eines Folienmasters
	Verwenden eines Folienmasters zum Hinzufügen von Text auf alle Folien

	Hinzufügen von Kommentaren zu einer Präsentation
	Bildschirmpräsentation einrichten
	Aus den gleichen Folien mehrere verschiedene Präsentationen erstellen
	Folienübergänge
	Automatisch zur nächsten Folie wechseln

	Ausführen einer Diashow

